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Product Information 
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 General 
Description 

 Learning 
Outcomes 

At the completion of Microsoft Office 2010 Upgrading you should be able to: 

 personalise and make changes to the Office 2010 user interface 
 use the help system tools available to you in Office 2010 
 work with the new file formats found in Microsoft Office 2010 
 use the more convenient printing settings in Office 2010 
 share your work with others directly through Office 2010 
 use the new formatting features found in Office 2010 
 use the new drawing and illustrating tools in Office 2010 
 understand what has changed in Microsoft Word 2010 
 find the standard page layout features of Word 2010 
 create and work with tables in Word 2010 
 create a mail merge operation in Word 2010 
 use the formatting features of Microsoft Excel 2010 
 work with Excel 2010's formulas and functions 
 work with tables in Excel 2010 
 use the charting features in Excel 2010 
 use the PivotTable features in Excel 2010 
 create effective presentations using the new and enhanced features of PowerPoint 

2010 
 work with many of the new features of Outlook 2010 
 create and read email messages in Outlook 2010 
 use the Calendar feature in Outlook 2010 
 work with Contacts in Outlook 2010 

 Target 
Audience 

 Prerequisites Experience in a version Microsoft Office prior to Office 2010 is essential for this course 
including experience in manipulating Office files, creating documents, workbooks, 
presentations, and emails.  

 Pages & 
Nominal 
Duration* 

312 pages . Watsonia Publishing Modules are based around a 2-day training program 
consisting of approximately 14 – 16 hours 

 Student Files Many of the topics in Microsoft Office 2010 Upgrading require you to open an existing file 
with data in it. These files can be downloaded free of charge from our web site at 
www.watsoniapublishing.com. Simply follow the student files link on the home page. You will 
need the product code for this course which is INF1000. 

 Methodology The In Focus series of publications have been written with one topic per page. Topic sheets 
either contain relevant reference information, or detailed step-by-step instructions designed 
on a real-world case study scenario. Publications can be used for instructor-led training, self-
paced learning, or a combination of the two. 

 Formats 
Available 

A4 Black and White, A5 Black and White (quantity order only), A5 Full Colour (quantity order 
only), Electronic licence 

* Duration relates to study time only and does not include assessment time. Duration should be used as a guide only. Actual duration will vary 
depending upon the skills, knowledge, and aptitude of the participants. This information sheet was produced on Wednesday, August 18, 2010 and 
was accurate at the time of printing. Watsonia Publishing reserves its right to alter the content of the above courseware without notice.  

This course is for users of versions of Microsoft Office prior to Office 2010, including Office 
2007, who are seeking a comprehensive upgrade experience.  

This course aims to provide skills and knowledge in a wide range of new features, 
enhancements, and changes found in Microsoft Office 2010. 
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Contents 

 The Office 2010 Interface 
 Understanding The Office 2010 

Interface 
 Starting An Office 2010 Application 
 Understanding The Ribbon 
 Using The Ribbon 
 Using Ribbon Key Tips 
 Minimising The Ribbon 
 Understanding The Quick Access 

Toolbar 
 Launching Dialog Boxes 
 Understanding The Status Bar 
 Understanding The Backstage 

View 
 Accessing The Backstage View 

 Personalising The 2010 Interface 
 Understanding Personalising The 

Interface 
 Showing And Hiding Ribbon Tabs 
 Modifying Ribbon Tabs 
 Creating A New Ribbon Tab 
 Placing Commands On A Tab 
 Organising Commands In A Group 
 Creating More Groups 
 Exporting Your Personalisation 

Settings 
 Removing A Tab From The Ribbon 
 Importing Personalisations 
 Resetting The Ribbon 
 Adding Commands To The QAT 
 Modifying Commands On The QAT 
 Removing Commands From The 

QAT 
 Resetting The QAT 
 Customising The Status Bar 
 Advanced Ribbon Customisation 

 The Office 2010 Help System 
 Understanding The Help System 
 Knowing Your Version And Build 
 Accessing Help In Office 2010 
 Offline Help 
 Help Getting Started With Office 

2010 
 Using The Menu To Ribbon Guide 
 Downloading 2003 To 2007 Guides 
 Using The 2003 To 2010 

Workbooks 
 Googling Help 
 Accessing Images And Pictures 
 Accessing Online Templates 

 The Office 2010 File System 
 Understanding Office 2010 File 

Types 

 Opening Files In Office 2010 
 Closing Files In Office 2010 
 Opening Recent Files And Places 
 Recent Files From The Start Menu 
 Understanding File Saving In 

Office 2010 
 Saving To A Previous Version 
 Saving As Macro Enabled 
 Creating A PDF File 
 Saving To The Web 
 Creating New Files In Office 2010 
 Understanding Templates In Office 

2010 
 Understanding Draft Versions 
 Configuring AutoSave 
 Recovering An Unsaved File 
 Managing Versions 
 Accessing File Information 

 Printing From Office 2010 
 Print Previewing In Office 2010 
 Choosing A Printer 
 Specifying Print Settings 
 Specifying Page Layout Settings 
 Changing Printer Properties 

 Sharing From Office 2010 
 Understanding Sharing 
 Sending A File As An Attachment 
 Sending A File As A PDF 
 Saving To SkyDrive 
 Protecting Your File Before 

Sharing 
 Checking For Issues 
 Checking File Accessibility 
 Checking File Compatibility 

 Formatting In Office 2010 
 Understanding Formatting In Office 

2010 
 Using Home Tab Commands 
 Applying Styles In Office 2010 
 Applying A Different Style Set 
 Applying Table Styles 
 Applying Themes 

 Pictures 
 Understanding Pictures 
 Inserting A Picture 
 Changing The Picture 
 Removing A Picture Background 
 Correcting Pictures 
 Changing Picture Colouring 
 Applying Artistic Effects 
 Changing Picture Styles 
 Changing Picture Effects 
 Repositioning Pictures 

 The Picture Format Short Cut 
Menu 

 Changing The Picture Layout 

 Drawing And Illustrating 
 Modifying Clip Art 
 Inserting Shapes 
 Modifying Shapes 
 Inserting Text Into A Shape 
 Custom Text Wrapping 
 Finding And Selecting Shapes 
 Using A Canvas 
 Inserting Screen Shots 
 Inserting A Screen Clip 
 Understanding SmartArt 
 Creating A SmartArt Image 
 Adding Text To SmartArt 
 Changing The SmartArt Style 
 Changing Colours In A SmartArt 

Image 
 Changing A SmartArt Layout 
 Adding More Shapes To SmartArt 
 Resizing SmartArt 

 Microsoft Word 2010 
 What’s New In Word 2010 
 Where Are They Now In Word 

2010? 
 The Word 2010 Screen 
 Word 2010 File Formats 
 Creating Building Blocks 
 Organising Building Blocks 
 Deleting Building Blocks 
 Spell Checking In Word 2010 
 Working With The Navigation Pane 
 Locating Non Textual Items 
 Applying Styles In Word 2010 
 Modifying Styles In Word 2010 
 Other Style Tricks In Word 2010 
 Enabling Actions 
 Clever Tricks Using Actions 

 Page Layout In Word 2010 
 The Page Layout Tabs 
 Changing Standard Page Setup 
 Inserting Section Breaks 
 Quick Headers And Footers 
 Saving A Header To The Gallery 
 Working With Custom Headers 
 Inserting Page Numbering 
 Inserting A Blank Page 
 Inserting A Cover Page 
 Watermarks And Page Colours 
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 Tables In Word 2010 
 Inserting A Quick Table 
 Using The Layout Tab 
 Using The Design Tab 
 Adding Calculations To A Table 
 Manipulating Text In A Table 

 Merging In Word 2010 
 Understanding Merging In Word 

2010 
 Merging Using The Wizard 
 Writing The Merge Letter 
 Completing The Merge 
 Creating Merges From The Ribbon 
 Running Merges From The Ribbon 
 Opening An Existing Merge 
 Working With Recipient Lists 

 Microsoft Excel 2010 
 What’s New In Excel 2010 
 Where Are They Now In Excel 

2010? 
 The Excel2010 Screen 
 Excel 2010 File Formats 
 Headings And Gridlines 
 Views Of The Worksheet 
 Print Options From The Ribbon 
 Spell Checking In Excel 2010 

 Formatting In Excel 2010 
 Simple Formatting 
 Clearing Cells 
 Applying Cell Styles 
 Modifying Styles 
 Applying Themes To Styled Cells 
 Understanding Conditional 

Formatting 
 Formatting Cells Containing Values 
 Top Ten Items 
 Working With Data Bars 
 Working With Colour Scales 
 Working With Icon Sets 
 Creating Your Own Rules 
 Understanding Sparklines 
 Creating Sparklines 
 Editing Sparklines 

 Working With Formulas 
 Using The Formula Bar And Name 

Box 
 Function Changes 
 The Formulas Tab On The Ribbon 
 Using The Formulas Tab 
 Using Range Names In Excel 2010 
 Creating Formulas With 

AutoComplete 
 Useful Statistical Functions 
 Working With The Name Manager 
 Using The Watch Window 

 Working With Tables 
 Understanding Tables 
 Creating A Table 
 Inserting Or Deleting Table 

Records 
 Removing Duplicates 
 Sorting Tables 
 Filtering Tables 

 Charting in Excel 2010 
 Creating A New Chart 
 Changing The Chart Type 
 Changing The Chart Layout 
 Changing The Chart Style 
 Formatting Chart Elements 
 Relocating A Chart 
 Saving A Chart Template 

 PivotTables In Excel 2010 
 Creating A PivotTable Shell 
 Dropping Fields Into A PivotTable 
 Filtering A PivotTable Report 
 Clearing A Report Filter 
 Switching PivotTable Labels 
 Formatting A PivotTable Report 
 Understanding Slicers 
 Creating Slicers 
 Creating A PivotChart 

 Microsoft PowerPoint 2010 
 What’s New In PowerPoint 2010 
 Where Are They Now In 

PowerPoint 2010? 
 The PowerPoint 2010 Screen 
 PowerPoint 2010 File Formats 
 PowerPoint 2010 Preferences And 

Settings 
 Creating A Presentation 
 Cropping A Picture 
 Aligning Objects 
 Building Equations 
 Creating Custom Shapes 
 Animating Objects 
 Copying Animations 
 Applying Slide Transitions 
 Creating Sections 

 Microsoft Outlook 2010 
 What’s New In Outlook 2010 
 Where Are They Now In Outlook 

2010? 
 Common Outlook 2010 Screen 

Elements 
 Navigating To Outlook Features 
 The Navigation Pane 
 The To-Do Bar 
 The Mail Screen 
 The Calendar Screen 
 The Contacts Screen 
 The Tasks Screen 
 The Notes Screen 

 The Outlook Today Screen 

 Outlook 2010 Mail 
 The Message Window 
 Creating A New Message 
 Checking The Spelling 
 Adding An Attachment To A 

Message 
 Adding Importance 
 Requesting Message Receipts 
 Opening An Outlook Data File 
 Adjusting The Message View 
 Arranging Messages 
 Understanding Conversation View 
 Navigating Messages In A 

Conversation 
 Replying To A Message In A 

Conversation 
 Finding Related Messages 
 Ignoring Conversations 
 Cleaning Up Conversations 
 Automating Common Tasks With 

Quick Steps 
 Customising A Default Quick Step 
 Creating A Quick Step 
 Using Quick Steps 
 Spamming And Junk Email 
 Phishing And Junk Email 

 Outlook 2010 Calendar 
 Accessing The Calendar 
 Changing The Calendar 

Arrangement 
 Displaying Specific Dates 
 Navigating Within A Calendar 
 Changing The Current View 
 Sharing Calendars 
 Working With Multiple Calendars 
 Scheduling An Appointment Using 

Click To Add 
 Scheduling Using The Appointment 

Window 
 Scheduling An Event 
 Scheduling Free And Busy Times 
 Categorising Activities 
 Scheduling A Meeting 
 Meeting Response Options 
 Responding To Meeting Requests 

 Outlook 2010 Contacts 
 Understanding The Contact Form 
 Understanding Electronic Business 

Cards 
 Viewing Your Contacts 
 Creating A New Contact 
 Entering Contact Details 
 Inserting A Contact Picture 
 Changing A Business Card Layout 

 Concluding Remarks 
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